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1. Introduction 

CLAS (C. Language Program ^Analysis System) is a Reverse 
Engineering tool intended for use in the Verification and 
Validation(V&V) phase of software programs developed in the 
ANSI ' C language. From the 'C source, code, CLAS generates data 
pertaining to two conceptual models of programs viz, Entity-
Relationship (E-R) model [1,2] and Control Flow Graph(CFG) 
model[3]. The E-R model of software programs, provides several 
valuable insights ( such as the file dependency information, the 
function call hierarchy, use of global variables etc.) into the 
design of the program. At a lower level of abstraction, the 
control flow graph model helps in analysing and detecting 
anomalies in the control flow, and provides support in unit level 
testing (white-box testing). These two models together do provide 
a substantial framework within which programs could be analysed. 
Browsing Tools within CLAS, make use of this data, to provide 
different graphical views of the programs analysed. 

CLAS provides an integrated Graphical User Interface (GUI) 
based environment under which ' C programs can be analysed and 
the analysed data can be viewed using the browsing tools. These 
browsing tools consist of 

(a) Call Graph Browser 
(b) Control Flow Graph Browser 
(c) Entity Relationship Browser 
(d) Report Browser 

These browsing tools can be invoked from the main control 
window of CLAS, referred as CLAS Base Window in this report. The 
GUI of CLAS consists of this CLAS Base Window, the analysis and 
browsing tools as mentioned above. This report discusses the GUI 
of CLAS. 

The GUI of CLAS is implemented using an OPEN LOOK ['1,5] 
compliant toolkit XVIEW on Sun SPARC IPC Workstation running Sun 
OS 4.1.1 rev B. In this document the OPEN LOOK keywords and CLAS 
keywords are differentiated by consistently following the 
following convention : 

All OPEN LOOK keywords are printed in italics and all 
application specific keywords are printed in bold e.g. in 
describing a button Browse Menu Button, Drowse is the title of 
the button and Menu Button is the type of the button. User inputs 
through keyboard are printed underlined. 

The re*-'̂ rt is organised as follows. Section 2 describes a 
review of . ~.vant OPEN LOOK Graphical User Interface components. 
Readers wh_ re familiar with OPEN LOOK GUI can skip section 2. 
Sections 3 to 7 describes the GUI of CLAS from the user 
perspective, section 8 describes the installation of the 
software and section 9 gives the references. Appendix A lists all 
the messages displayed during analysis. 
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2. Review of OPEN LOOK GUI Components 

The Mouse 

The mouse button actions used in the CLAS follow standard 
OPEN LOOK conventions viz, leftmost(SELECT) mouse button selects 
the default option associated with the button. The 
rightmost(MENU) button activates the menu associated with the 
button. For any set of menu options the first option is the 
default option. The middle(ADJUST) mouse button is used to 
adjust(extend or reduce) the selection. 

The following terms are used to describe the actions that the 
User can take with the mouse and the pointer 

Press : Push a mouse button and hold it 
Release : Release a mouse button 
Click : Push and release a mouse button before moving the 

pointer 
Double-click : Push and release a mouse button twice in quick 

succession without moving the pointer 
Move : Slide the pointer without pushing any mouse 

buttons 
Drag : Push a mouse button and hold it down while 

moving the pointer 

The phrase "dragging an object" is short for placing the 
pointer over an object, pushing the SELECT button on the mouse, 
moving the pointer until the object is in the desired new 
location, and releasing the SELECT button. Hereafter when 
describing actions on mouse buttons they are just referred by the 
name e.g. click SELECT, press MENU etc. 

OPEN LOOK Components 

The OPEN LOOK GUI specifies the look and feel of certain 
components that provide the structural framework in which the 
application is presented to the users. They include the following 
elements 

(1) Base window 
(2) Pane 
(3) Pop-up window 

-Command window 
-Property window 
-Help window 
-Notices 

(1) Base Window : The base window is the primary window in which 
the application presents the data. The standard base window 
usually have the following elements 

(a) The standard base window menu containing items to allow 
users to perform the standard window management functions 
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of closing the window to an icon, expanding it to a full 
size, changing generic window properties, moving it to 
back of the workspace behind any overlapping windows, 
refreshing the window and quitting the application 

A header with the title of the application and a window 
menu button at the left 
An iconic representation of the window 
At least one of the following 

(i) A control area containing control items described 
later 

(ii) A pane where the application presents the data to 
the user 

and optionally 

(e) Four Resize Corners where the user can move tVie pointer 
and drag the corner so that the window becomes of desired 
size 

(f) A footer for displaying one line status and error 
messages 

(2) Pane : Panes are bordered areas in which application presents 
the data to the user. The data can be graphic or textual or both 
in nature. Applications can provide the following optional 
functionality for panes: 

(a) Scrolling : OPEN LOOK GUI supports two kinds of scrolling 
Panning : Users can move the view of the data in the pane 

directly by dragging. 
Scrolling by scrollbar : Users can move the view of 

the data by manipulating the OPEN LOOK GUI 
scrollbar. Scrollbars are a special type controls 
that make it easy for the users to view objects 
such as drawings, documents etc. that extend 
beyond the size of the panes. 

(b) Selectable pane border 
(c) Resizable adjacent panes 
(d) Splittable panes 
(e) Joining of split panes 

(3) Pop-up Windows 

The OPEN LOOK GUI provides four kinds of pop up windows that 
users can display and dismiss from the base window of the 
application 

(a) Command windows set parameters and execute commands 
based on these parameters. 

(b) Property windows set more persistent properties associated 
with an object, an application, or a window. 

(c) Help windows display help text for the area under the 
pointer 
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(d) Notices are special pop-up windows that are used to 
display messages and conditions that must be brought to 
the user's attention. 

All pop-up windows except Notices have the following 
required elements 

(i) The standard pop-up Window menu 
(ii) A header with the title of the application and a pushpin 

and optionally the following 
(iii) A footer 
(iv) Resize corners 

OPEN LOOK GUI Controls 

The OPEN LOOK GUI specifies the look and feel of certain 
control items, which the user can depend upon to behave in the 
same way regardless of what application they control. Some of 
these control components are briefly discussed below. 

Buttons 

Buttons are used for single commands and are typically 
used in control areas. The name of the command is usually the 
title on the button. 

Buttons are of three types named command button, window 
button and menu button. 

Command buttons are the simplest type and the name of the 
command is the title or. the button. Clicking a command button 
causes the command to be executed. 

Window buttons have a window mark, three dots, following 
the label. Clicking a window button causes a window to be 
displayed. The window can be either a base window ( in 
application with multiple base windows) or a pop-up window. 
Users then choose the command from the controls provided in 
the window. 

Menu buttons are used to display menus containing 
additional controls. Menu buttons always have a menu mark, an 
outlined triangle following the label. The triangle points 
where the menu will be displayed. 

Menus 

The OPEN LOOK GUI provides three basic types of menus: 

(1) Button menus, which users can display by choosing a menu 
button 

(2) Pop-up menus, which pop up at the pointer location and 
control the region under the pointer 
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(3) Submenus, which users can display from other menus 

Menus can have pushpins which can be used to pin the menu. 
Menus also have items to provide the same functionality as 
buttons. Just as command buttons, window buttons and menu 
buttons are used in control area, command items, window items 
and menu items are used on menus. 

Exclusive Settings 

Exclusive settings are used when objects selected by users 
have a state and state can be changed. Users can make only one 
choice from each group of settings. 

Exclusive settings are displayed as touching rectangles. 
The chosen setting is shown with bold background. 

Nonexclusive Settings 

Nonexclusive Settings are provided when users can set many 
values for one particular object. Nonexclusive settings are 
displayed as separate rectangles. Users can choose all, none 
or any combination of nonexclusive settings for the same 
object. 

Check Boxes 

Check boxes are used to set a Yes/No or On/Off type 
choice. Users can choose all, some, or none of the options by 
toggling the check box to display or suppress the check mark. 

Abbreviated Buttons 

Abbreviated buttons provide the same functionality as 
buttons but take up less space. Abbreviated buttons are small 
square buttons with no text label inside them. They can have a 
glyph inside the button. 

Text Fields and Numeric Fields 

Text fields allow users to type input from the keyboard. 
When a text field cannot display the entire string, scrolling 
buttons are displayed to allow the users to scroll the 
contents of he field. 

Numeric fields are special type of text fields that can 
contain only numbers and have increment/decrement scrolling 
buttons; users can click on them to increase or decrease the 
number displayed in the numeric field. 

Scrolling Lists 

Scrolling lists are similar to settings. The basic 
purpose of a scrolling list is to present an variable length 
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list of items in a small, well defined region. The scrolling 
list in its bnsic form is list of items which users can 
scroll by clicking on the scrollbar. OPKN LOOK GUI supports 
exclusive and nonexclusive scrolling lists. 

For details of these please refer to [4,5] 
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3. Invocation of CLAS and CLAS Base Window 

3.1 Invocation of CLAS 

CLAS can be invoked from the Open Windows file manager by 
clicking SELECT on the icon for CLAS. Alternatively it can also 
be invoked from the console window by typing clas and pressing 
return key. 

3.2 CLAS Base Window 

When CLAS is invoked it displays a base window, as shown in 
Figure 1 containing a control area and a pane. The base window 
header shows the application name as CLAS. 

Control Area 

The control area contains the following four buttons 

Project Menu Button 
Analyse Menu Button 
Browse Menu Button 
Quit Command Button 

Pane 

The pane displays the welcome message " Welcome to CLAS" and 
other information. 

Initially the Analyse Menu Button and Browse Menu Button are 
inactive and they remain so till a project is selected through 
the Project Menu Button. 

Actions of various buttons on the control area are described 
below. 

3.2.1 Project Menu Button 

The Project Menu Button is used to install a project under 
CLAS or to select or delete an existing project. Clicking 
SELECT on this displays the Pulldown Menu containing the 
following items 

Select... ( Default ) 
Install... 
Delete... 

Select... 

This item displays a command window, as shown in Figure 
2 containing a Project List and a text field named Project 
and two command buttons named Show File List and Load. The 
scrollable Project List displays all the projects currently 
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installed under CLAS. (A project which is currently being 
installed, analysed or browsed is prefixed with a pattern.) 

Selection of a project can be done in the following two 
ways. 

Any project can be directly selected by clicking the 
SELECT button on the project name in the scrollable list. 

Alternatively the project name can be typed in the 
text field named Project and can be selected by clicking 
SELECT on the Load command button. 

The Analyse Menu Button and Browse. Menu Button of the 
base window shown in Fig. 1 use the selected project by 
default. A user ( as identified by userid under UNIX ) can 
select projects installed by that user only. 

If the selected project has been already analysed, the 
file dependency graph is automatically displayed on the 
scrollable pane and the window header will show the project 
selected as shown in Figure 4. The footer shows the number 
of files in the file dependency graph. The small rectangles 
in the file dependency graph show file name (only the first 
14 characters from the actual name) and arrows show include 
dependency between them. For example, file 'printerr.c' 
includes the file 'stdlib.h' and it is shown by an arrow 
from 'printerr.c' to 'stdlib.h'. 

By clicking SELECT on Show Pile List command button 
the list of constituent files for a project can be viewed. 

Install... 

This item allows the user to install a project under 
CLAS. Clicking SELECT on this item initially displays a 
command window containing a text field named as Project 
Name and the user is required to enter the project name 
(limited to 32 characters) to be installed. If the project 
is already installed the user is notified but additions or 
deletions of files to or from the project file list are 
allowed. In both the cases a command window, as shown in 
Figure 3 named Install Project Form to be filled up by the 
user is popped up. 

Install Project Form: The form consists of three text 
fields named as Directory, File and Include Flag 
respectively and also two mutually, exclusive check boxes 
named as Source File and SCCS File. 

The project consists of a list of .c files. Each file 
in the project is identified by name and full path name of 
the directory where it resides, the search paths of 
directories where include files ( type .h ) can be found'. 

8 



The file type can be indicated using the exclusive check 
box named File Type. The file type is SCCS File if source 
file is under SCCS control else file type is Source File. 
If the user has specified file type as SCCS File by ticking 
in the corresponding check box, a text field named Version 
Number will be displayed and the user is required to enter 
the required version number. If the user does not specify 
the version number CLAS will automatically use the most 
recent version of that file. 

Note: The SUN OS implementation of SCCS assumes that if a 
file is under SCCS control then its SCCS data and history 
files will be under subdirectory named SCCS. The same 
convention is used here also. ( A project installed by a 
user is available for analysis and browsing by that user 
only). 

There are four command buttons on this command window 
and their actions are described below 

Add When a file is defined completely as described 
above it can be Added to the project by clicking SELECT on 
this button. The acceptance of the file is shown by 
displaying the file in the Scrollable File List. If the 
file is not found or not properly defined then the user is 
notified appropriately. 

Delete A file included in a project can be deleted from 
the file list of that project by properly defining the file 
as in Add command button and then clicking SELECT on the 
Delete button. Once the file is deleted the Scrollable File 
List is updated. If the file is not properly defined the 
user is notified and deletion will not take place. 

Save The project as defined by files included in the 
project and as displayed in the Scrollable file list, can 
be saved by clicking SELECT on this button. 

Cancel This command button can be used for canceling 
any operation and dismissing the command window. 

Delete... 

This item is used to delete a project from CLAS. 
Clicking SELECT on this item displays a command window 
• containing a scrollable Project List and a text field named 
Project and one command button Delate. The scrollable 
Project List displays all the projects currently installed 
under CLAS. (A project which is currently being installed, 
analysed or browsed is prefixed with a pattern.) 

User can delete a project by clicking SELECT on the 
project name shown on scrollable list or by typing its name 
in the textfield named Project and clicking SELECT on the 
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Delete command button. Once a project is deleted CLAS 
deletes all internal datafiles pertaining to that project 
automatically. 

3.2.2 Analyse Menu Button 

Pressing MENU on this menu button brings the pulldown 
menu containing two items 

Execute... (Default) 
Settings,. .. 

EKecute... 

The analysis of the selected project can be started by 
clicking SELEC7.' on this item. This item displays a command 
window containing a control area and a pane ( hereafter 
referred to as tty window ). The control area contains five 
command buttons namely Start, Pause, Show Log File, Delete 
Log File and Abort. The action of these buttons are 
described below. 

Start Clicking SELECT on this button actually starts 
the analysis phase. The analysis is carried out by calling 
the analyser "cana" for each file and the pertinent 
messages will be displayed on the tty window. The 
incremental mode analysis by CLAS ensures that only those 
fil.es are analysed which are added or modified since last 
analysis of the project. 

Pause While the analysis is going on the user can 
pause at any tints and can. gq through the messages or any 
error conditions, Once the Pause button is activated by 
clicking SELECT, the button label is changed to Restart for 
restarting the analysis from the point where it was paused. 

Sta:<r Lag ¥ 12.it £is I 'con During analysis whatever messages 
ara displayed on the tty window, are logged on to a file if 
proper options (as explained in Settings option) are set. 
Clicking SELECT on this button displays the log file on a 
separate cosnaisnci window containing a scrollable pane. This 
window can be dismissed by the associated window menu 

Dalot® Log Wil® This button is deactivated while the 
analysis is going on. At other times clicking SELECT on 
this command button deletes the current log file and 
deactivates Show Log File button and this button. 

aJbort Clicking SELECT on this button during analysis 
stops the analysis phase and all internal scratch files are 
deleted and the command window is dismissed. If no analysis 
in progress, clicking SELECT on this button will dismiss 
the command window. 
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Settings... 

The analysis of a project can be carried out with 
certain settings. Clicking SELECT on this item displays a 
command frame containing two groups of options for settings 
viz. Debug Opticas and Beautif ication and For loop 
Transformation optioms, as shown in Figure 5. 

The Debug Options consist of the following four 
nonexclusive choice boxes 

(i) Varboss daimg: setting this option enables verbose 
output during analysis phase which mainly consists of name 
of file being analysed, phase of analysis and all pertinent 
errors and warning messages. In addition the these the 
output will also show information regarding the internal 
state of analysis. This option is primarily useful fox-
testing purpose and not useful to CLAS users. 

If this option is not set then the output consists of 
name of file being analysed, phase of analysis and all 
pertinent errors and warning messages. 

For a detailed list of all messages please refer to 
Appendix A. 

(ii) Pause after each function: setting this option 
enables the analysis to proceed function by function. The 
user is prompted to restart the analysis after every stop. 

(iii) V&nss after each file: setting this option 
enables the analysis to proceed file by file. The user is 
prompted to restart the analysis after every stop. 

(iv) Msssaga Leg: setting this option saves all the 
messages during analysis in the specified file. 

The Beanstif issation option consists of mainly two 
nonexclusive choice boxes as described below? 

(i) imdsaitsiiGia ¥alue : this sets the indentation used 
in the beautified C program text. The default is 2 spaces 
and user can set up to 6 spaces. It is a numeric text field 
with increment and decrement buttons. 

(ii) '"For" Lce-p Trans format icm this option if set 
would cause all "for" loops in the original C text to be 
translated into equivalent While loop in the beautified C 
program text-
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3.2.3 Browse Menu Button 

Pressing MENU on this button displays items containing 
options of invoking the following browsers 

Call Graph Browser... (Default) 
Control Plow Graph Browser... 
Entity Relationship Browser... 
Report Browserc.. 

These browsers are described in sections 4 to 7 

3.2.4 Quit Command Button 

Click SELECT on this button to dismiss the CLAS base window. 
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4. Call Graph Browser 

The Call Graph Browser is a graphical browsing tool for 
viewing the call graph data of the analysed project. This browser 
displays a Jbase window (here after referred as Call Graph Browser 
Window), as shown in Figure 6, containing a control area, and a 
pane. The control area contains the following buttons 

View Menu Button 
Options Menu Button 
Locate Function Command Button 
Plot Command Button 
Quit Command Button 

and the pane is used for drawing the graph. Initially the pane 
displays a message " No graph to browse". 

4.1 View Menu Button 

Clicking MENU on View Menu Button displays a pulldown menu 
containing the following items 

Display All (Default) 
Hide All Library calls 
Hide ANSI Library Calls 
Hide User Library Calls 

Display All 
Clicking SELECT on this menu displays the entire call 

graph for the project in the pane on the base window 
having two scrollbars for scrolling the call graph/ The 
generation of the call graph and drawing on the pane can 
take time. During this time the message "Processing.. 
Please Wait" is displayed on the pane and the current 
- processing phase is displayed on the window footer. 

The call graph is shown by rectangles containing the 
function names inside (only the first 14 characters are 
shown) and calling relationship is shown by arrows from the 
calling to called functions. Functions which come at the 
first level( no incident arrow) are the functions which are 
not called. The base window header will show the project 
name whose call graph is currently displayed and the footer 
will display the total no of functions. Figure 6 shows 
partial view of a call graph. 

Functions are classified by their types(undefined 
function, library function etc.) and each type is shown by 
different visual attributes. These attributes are a pattern 
with the type name in the background. Following scheme is 
followed. 

Function defined and used :: Normal background 
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Undefined function :: Background with string "UF" 
Library function :: Background with string "LF" 

Hide All Library calls 

ClicXing SELECT v<n this item displays the call graph 
for the project showing calling relationship between all 
functions leaving out all library functions. This call 
graph will be more readable than the earlier because of 
less number of functions. All other operations are 
identical to the previous item. 

Hide ANSI Library Calls 

Clicking SELECT on this item displays the call graph 
for the project showing calling relationship between all 
functions leaving out all ANSI library functions. This call 
graph will be more readable than the earlier because of 
less number of functions. All other operations are 
identical to the previous item.. 

Hiae User Library calls 

Clicking SELECT on this item displays the call graph 
for the project showing calling relationship between all 
functions leaving out all user library functions. This call 
graph will be more readable than the earlier because of 
less number of functions. All other operations are 
identical to the previous item. 

4.2 Options Menu Button 

This menu button will act on any 'C function selected in 
the call graph. A function can be selected by clicking the 
SELECT button on the bounding rectangle containing the 
function (selection of a function is shown by changing the 
shade of the containing rectangle) and then clicking MENU on 
this button will display a pulldown menu containing the 
following items 

Source Code... ( Default) 
Control Flow Graph... 
Functions Calling. 
Functions Called... 
Global variables Used... 
Metrics... 
Redraw Graph 

The same menu can also be activated by pressing MENU 
button on the function. If a function is not selected as 
explained above then the user will be notified appropriately. 
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Source code... 

Clicking SELECT on this item displays a command window 
having a control area and a pane with two scrollbars for 
horizontal and vertical scrolling. Source code pertaining 
to the selected function is displayed in the pane. 

control flow Graph... 

Clicking SELECT on this item displays the control flow 
graph of the selected function on a new base window. For 
further operations please refer to the section 6 describing 
Control Flow Graph for operations available. 

Functions calling... 

Clicking SELECT on this item displays a Jbase window 
containing a control area and a pane. The pane will display 
a list containing functions calling the selected function. 
User can use the scrollbar to view the list displayed. Each 
line in the list will consist of the function name, file in 
which the calling function occurs, the line number in which 
the call occurs and the occurrence count. For a detailed 
description please refer to the section 5 on Relations 
button in the Entity Relationships Browser. The control 
area of this window contains a command button Quit to 
dismiss it. 

Functions called... 

Clicking SELECT on this item will display a base window 
containing a control area and a pane. The pane will display 
a list containing functions called from the selected 
function. User can use the scrollbar to view the list 
displayed. Each line in the list will consist of the 
function name, file in which the calling function occurs, 
the line number in which the call occurs and the occurrence 
count. For a detailed description please refer to the 
section 5 on Relations button in the Entity Relationships 
Browser. The control area of this window contains a command 
button Quit to dismiss it. 

Global Variables Used... 

Clicking SELECT on this, item will display a base window 
containing a control area and a pane. The pane will display 
a list containing global variables used by the selected 
function. User can use the scrollbar to view the list 
displayed. Each line in the list will consist of the 
function name, file in which the selected function occurs, 
the line number in which the use occurs and the occurrence 
count. For a detailed description please refer to the 
section 5 of Relations button in the Entity Relationship 
Browser. The control area of this window contains a command 
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button Quit to dismiss it. 

Metrics... 

clicking SELECT on this item displays a command window 
containing a control area and a pane. The control area 
consists of nonexclusive settings named Lines of Executable 
Code, Halstead's Metrics, McCabe's Number, Loop Nesting 
Depth, Fan In & Fan Out, Path Complexity Metrics and All 
Metrics (overrides all other settings and displays all the 
metrics). The control area also contains a command button 
Apply. User is required to set the nonexclusive settings 
and click SELECT on Apply button. All the metric values 
indicated by the settings would be displayed on the pane. 

Redraw Graph 

This item enables the user to view the graph with more 
clarity by redrawing the graph with the selected function 
as the new root. This item has a pullright menu containing 
following items 

All levels... ( Default) 
Specified levels... 

All levels... 

Clicking SELECT on this item displays a new window 
identical to the call Graph Browser Window and the call 
graph rooted at the selected function is drawn on the 
pane inside the new window. The same functionality (e.g. 
same set of buttons etc.) is available on the control 
area of the new window as in the base window. 

Specified levels... 

Clicking SELECT on this item displays a new window 
identical to the call Graph Browser? Window and a 
command window. 

The command window displays the selected function 
name, maximum level of the subgraph rooted at the 
selected function and contains two numeric text fields 
named Start Level and End Level and assossiated up and 
down scroll buttons. It also contains a command button 
named Apply. Initially the start Level text field 
contains 1 and the End Level text field contains the 
maximum level available rooted at the selected function. 

User has to select proper levels and click SELECT on 
the Apply command button. The subgraph is displayed on 
the pane inside the new window. The same functionality 
(e.g. same set of buttons etc.) is available on the 
control area of the new window as in the base window. 
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4.3 Locate Function Command Button 

User can can use this button to bring in view a portion of 
the call graph containing a selected function inside the pane. 
This button works in association with the text field named 
Function in the control area. 

User is required to type in the function name in text 
field and then click SELECT on the button to view the portion 
of the call graph containing the function. If the function 
does not exist user is notified appropriately. 

4.4 Plot Command Button 

This button is not implemented. 

4.5 Quit Command Button 

Click SELECT on this button to quit the Call Graph Browser 
Window. User is notified for confirmation. 
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5. Entity Relationship Browser 

The Entity Relationship browser is a text based interface 
which provides the functionality for viewing and querying data 
pertaining to the E-R model of the selected project. 

5.1 The Entity Relationship Browser Base Window 

The Entity Relationship Browser base window consists of a 
control area and scrollable text pane as shown in Figure 8. The 
text pane displays a subset of an entity set ( such as Files or 
Functions in the project) in the form of a list sorted 
alphabetically on the entity name. Each row in the list 
corresponds to a unique entity from the above subset, while the 
columns indicate the attributes associated with that entity. The 
header of the Entity Relationship Browser window always displays 
the name of the project being browsed. The left footer displays 
the number of entities present in the list currently displayed in 
the text pane. 

The Control Area 

The control area provides buttons for specifying the entity 
set to be loaded Load... window button, specifying filter 
conditions props window button or performing manual operations 
Edit menu button to prune the entity set being displayed (i.e. 
create a subset), selecting the attributes that should be 
displayed for each entity Props window button and viewing the 
relationships between entities Relations... window button. 

The functionality provided by these buttons is described in 
the following sections. 

5.1.1 The Load... Window Button 

On clicking SELECT on Loaa... , the pop-up command window 
shown in Figure 7 is displayed. The Project Name text field 
displays the selected project name and use the Entity Set 
exclusive settings to specify the entity set to be displayed 
in the text pane. Clicking SELECT on the view command button 
on the pop-up window causes the text pane to display a list 
containing all entities v/ith its specified attributes for 
that entity set, overwriting any previous list. Specifying a 
project and entity set which 'is currently displayed in the 
text pane would result in the entire entity set being 
displayed thus nullifying the effect of any prior filtering 
operations. A notice prompts confirmation or cancellation of 
the above operation before it is actually carried out. 

The load operation may be canceled by clicking SELECT on 
the Cancel command button in which case the display in the 
text pane remains unchanged. If the browser is unable to load 
the project/entity set pair, a notice displays a message to 
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that effect. Use the Retry or Cancel buttons on the notice 
window to retry or cancel the load operation. 

5.1.2 The Edit Menu button 

This button provides a pulldown menu shov/n in Figure 11 to 
perform manual editing of the list in the text pane. To 
perform some of the editing operations one or more entities in 
the list have to be selected. To select an entity click SELECT 
anywhere on the line containing the entity. To select more & 
than one entity, click SELECT on the line containing the first 
entity and then click ADJUST on each additional entity. To 
clear prior selections, without defining a new selection, 
click SELECT on the title line in the text pane. The 
functionality of each of the items in the pulldown menu is 
described below:-

The Undo item provides pullright options to undo the last 
operation or all operations performed on trie list and restore 
the list to that prior to the operation(s). 

The Select All item causes all entities in the current 
list to be selected. 

Use Copy to store a copy of the selected entities in the 
clipboard. The contents of the clipboard are overwritten. A 
notxce prompts confirmation prior to carrying out the 
operation. 

Use Cut to remove the selected entities from the displayed 
list and store in the clipboard. The contents of the clipboard 
are overwritten. A notice prompts confirmation prior to 
carrying out the operation. 

Use Paste to insert the clipboard contents in the list in 
the text pane. 

Use Delete to delete entities from the list without 
storing them in the clipboard. All entities which are selected 
are deleted from the list. 

Use Show clipboard to view the contents of the clipboard. 
On choosing this menu item, the pop-up subwinr.ow shown at the 
bottom of Figure 11 is displayed. This subwindow displays a 
list of the entities in the clipboard. If the clipboard 
contents are not pertaining to the entity relationship 
browser, a message to that effect is displayed in the 
subwindow. Use the Quit command button in the control area of 
the subwindow to dismiss the subwindow. 

5.1.3 The Props Window button 

On clicking SELECT on Props , the pop-up command window 
shown in Figure 9 is displayed. Use the control items provided 
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in the window to specify the attributes to be displayed and 
filtering conditions that are to be applied to the list in the 
text pane. After the appropriate choices are made, clicking 
SELECT on the Apply command button causes a new list to be 
displayed in the text pane. This list is the result of 
applying the specified display and filtering options on the 
previously displayed list. Clicking the Cancel command button 
causes no change in the list in the text pane and restores the 
display and filtering options to that which was used for the 
last filtering operation on the list. The control items that 
can be used to set the displayed attributes and filtering 
conditions are described below:-

The Displayed Attributes nonexclusive check boxes 
determines which attributes of the entity set are to be shown 
when the entity set is displayed in the text pane. Clicking 
SELECT on the Apply command button to update the list in the 
text pane, atleast one of the attributes should be enabled for 
display, failing which a jjotice prompts either a retry (i.e. 
re-enter new filtering and display options) or a cancel (i.e. 
the filtering and display options are restored to that which 
existed prior to the user making his new choices). In Figure 9 
the attributes of the 'Function' entity set enabled for 
display are the FunctionName, Linkage and NoOfArgs. 

Filtering options are set with the help of the control 
items grouped below the message item Filter Conditions. Each, 
line iias control items associated with one attribute of the 
entity set displayed in the text pane. For each attribute, use 
the exclusive check box beside the attribute to enable 
filtering based on that attribute. When enabled, a group of 
control items appear beside the checkbox. The options 
available to specify the filtering condition is determined by 
the type of the attribute (i.e. whether the attribute is 
string valued, integer valued or is an enumeration). 

For string valued attributes, use the text field beside 
the exclusive check box to specify the matching string. When 
the list in the text pane is updated, only those entities 
having the specified string as the corresponding attribute 
value are displayed. To specify the prefix of the matching 
string rather than the exact string, append the wildcard 
character '*' to the matching prefix. 

For integer valued attributes, a relational operator (e.g. 
greater than) and a numeric value have to be specified. Use 
the abbreviated menu button beside the checkbox to specify the 
relational operator and the text field beside it to enter the 
numeric value. 

For attributes whose value is one of a fixed set of 
choices (i.e. enumeration), use the nonexclusive choice item 
beside the checkbox to disable or enable a particular value in 
the enumeration. When the list in the text pane is updated, 
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only those entities which have the enabled enumeration values 
as the corresponding attribute values are displayed. 

Filter Conditions may be specified for more than one 
attribute. In such a case, on applying the filter conditions 
only those entities which meet all the filtering conditions 
are included in the displayed list. 

On updating the list based on the filtering options set in 
Figure 9, only those functions whose name starts with an 'a' 
and are defined are included in the list. 

A message item at the bottom of the pop-up window 
indicates whether the clipboard has been used to generate the 
list in the text pane. The message item is not shown in case 
the clipboard has not been used. 

1.4 The Relations Window button 

The Relations Window button may be used to view 
relationships between entities. An entity A is related to an 
entity B if the definition of A refers to B in some way. Here 
A would be the defined entity and B the referred entity. Hence 
to view relationships, the collection of defined entities and 
the collection of referred entities are to be specified. Each 
of the above mentioned collections are required to be 
homogenous(i.e. for each collection, the members must belong 
to one entity set). Clicking SELECT on the Relations Window 
button, a pop-up command window is displayed. 

Use the Defined entity list exclusive settings to specify 
the collection of defined entities for which the relationships 
are to be considered. Choosing Files, Functions, Globals, or 
Types implies that the collection of defined entities is the 
corresponding entity set in its entirety. Choosing Displayed 
entities implies that the collection of defined entities 
include only those entities displayed in the list in the text 
pane. The Clipboard entities or selected entities may be 
chosen provided the clipboard selection or primary selection 
is currently held by some invocation of the entity 
relationship browser. In such a case, the collection of 
defined entities would comprise of all entities stored in the 
clipboard or all selected entities in the text pane 
respectively. 

Use the Referred entity list exclusive settings to specify 
the collection of referred entities to be considered when 
displaying the relationships. The choices and corresponding 
semantics are identical to that for the collection of defined 
entities. 

Figure 10 shows the controls that are to be set for 
displaying the functions that use a particular global 
variable. As global variables are referred to in a definition 
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of a function, the defined entity set should be. the entire set 
of functions. To chose only a particular global variable, the 
global variable entity set is loaded and the required variable 
is selected. The Selected Entities item is chosen among the 
choices in the Referred entity list. 

Use the Displayed Attributes nonexclusive check boxes to 
choose what attributes of the relationship are to be 
displayed. 

Clicking SELECT on the View command button, the pop-up 
subwindow shown at the bottom of Figure 10 is displayed. This 
subwindow contains a scrollable text pane and a control area. 
The scrollable text pane displays a list, where the content of 
each line depends upon the attributes of the relationship 
chosen for display. This dependence is elucidated next:-

If all the attributes of the relationship are chosen for 
display, then each member of the relationship set is uniquely 
identified by the combination of a defined entity, a referred 
entity and the line number (called key attributes) in the file 
where relationship occurs. The occurrence count refers to the 
number of times. the referred entity is referred to in the 
given line number. However if one or more of the above three 
attributes is not chosen for display, the list would contain 
members which have the same value for the displayed key 
attributes. All such members are replaced by a single member 
whose occurrence count is the sum of the occurrence counts of 
the replaced members. Each member so obtained is displayed on 
a separate line. The total number of members in the 
relationship set after merging all duplicate members is 
indicated at the left footer of the subwindow. 

The control area of the subwindow has a Quit command 
button which may be used to dismiss the subwindow. 
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6. Control Plow Graph Browser 

The Control flow graph browser is a graphic tool by which 
control flow related information pertaining to functions of the 
analysed project may be viewed. 

6.1 The Control Flow Graph Browser Base Window 

The Control Flow Graph Browser base window consists of a 
control area, two scrollable graphics panes and a scrollable text 
pane as shown in Figure 12. The three panes form the coordinated 
display windows to show control flow data and present alternate 
views of the control flow data (source code, loop hierarchy and 
flow graph) for a given function. 

6.1.1 Display Fanes 

Following are the three display panes 

Loop Hierarchy Pane 

The graphics pane at the upper left position displays the 
loop hierarchy for the selected function in the form of a tree. 
The root of this tree represents the whole program. Every other 
node in the tree corresponds to a unique loop in the function. An 
arrow from one loop to another indicates that the latter is 
embedded in the former. For the function whose control flow data 
is displayed in Figure 12, there are three loops. Loop L3 is 
embedded in the loop L2. 

The numbers displayed within the nodes serve as identifiers 
for the corresponding loop and are prefixed by 'L' to conform 
with the naming conventions in the control flow graph pane. 

Control Flow Graph Pane 

The graphics pane at the bottom displays either flow of 
control within any one of the loops of the function or the flow 
of control within the whole function. The flow of control is 
depicted as a directed graph. Each node in the graph represents a 
collection of sequential statements (called a block) or a loop 
(in which case the flow of control within the loop is hidden). 
The edges represent the syntactically possible flows of control 
between nodes. In Figure 12. the flow graph of the whole function 
is displayed. The Loop L3 is represented as a single^ node. 

Numbers displayed within the nodes are used to identify the 
corresponding block or loop. The number is prefixed by 'L' or 'N' 
depending on whether the node represents a loop or a block. The 
same numbers are used in this pane and the loop hierarchy pane to 
identify a loop, thus ensuring greater ease in cross-referencing 
between the two alternate views of the control flow data. 
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Source Code Pane 

The text pane at the upper right displays the source code for 
the selected function. 

6.1.2 Control Area 

The control area provides two buttons. Load... window button 
for selecting a function whose control flow data is to be 
displayed. The View menu button for selectively exposing or 
hiding parts of the flow graph. 

The Load... Window Button 

Clicking SELECT on Load... , the pop-up command window 
shown in Figure 13 is displayed. The Project Name text field 
displays the selected project. 

The Function List exclusive scrolling list displays an 
alphabetically sorted list of functions which are defined in 
those files which are marked in the File list nonexclusive 
scrolling list. To start with, by default all items of the 
File list are marked • and the first item in the Function list 
is marked for subsequent display. At any time atleast one 
member of the File list should be marked failing which a 
notice displays a message to that effect. Use the Ok button on 
the notice to resume the load operation. 

The Function Name and File Name text fields, placed below 
the Project Name text field display the marked item in the 
Function list and the file in which it is defined. Clicking 
SELECT the View command button, the control flow data of the 
function marked in the Function List is displayed in the 
graphics and text panes of the control flow graph browser, 
overwriting any previous data displayed there. Clicking SELECT 
on the Cancel command button the panes of the control flow 
graph browser remain unchanged while the controls on the pop
up command window are restored to that which existed on 
clicking SELECT on the Load... command button. 

The Function Name and File Name text fields may also be 
used directly to specify the function whose control flow data 
is of interest. Use the File Name text field to enter the 
name of the file in which the required function is defined. On 
pressing carriage return in this text field, only that item in 
the File list is marked and those functions defined in this 
file are displayed in the Function List . By default the first 
item in the Function List is marked, so that the control flow 
data of this function can be displayed on clicking SELECT on 
the View command button. Use the Function Name text field to 
enter the name of the required function and press carriage 
return to update the Function List . Clicking SELECT on the 
View command button the control flow data of the required 
function will be displayed. If the choice of the file name or 
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the Function name entered in the corresponding text fields is 
not found in the File List or Function List scrolling lists 
respectively, a message is displayed to that effect in the 
right footer of the command window and the text field entries 
are restored to their previous values. 

The View Menu button 

To enable operations that are performed by pulldown items 
associated with the View Menu button, a selection has to be 
made. 

Performing Selections 

Either a block or a loop may be selected. To select a 
loop, click SELECT on the corresponding node in the loop 
hierarchy tree displayed in the loop hierarchy pane. The node 
is highlighted in the loop hierarchy pane. Depending on the 
contents of the control flow graph pane, 

(a) The blocks and loops contained in the selected loop are 
highlighted in the control flow graph pane. This is the 
case when the flow graph of the selected loop is 
visible in the control flow graph pane. 

(b) The node representing the selected loop is highlighted 
in the control flow graph pane. In this case, the flow 
of control within the selected loop is not visible, but 
the loop is depicted as a single node in the control 
flow graph pane. 

(c) There is no change in the display in the control flov; 
graph pane. This is the case when, neither the flow of 
control within the selected loop nor the loop is 
visible. 

A loop may also be selected by clicking SELECT on the 
corresponding node in the control flow graph pane, if the loop 
is shown as a node in the pane. 

To select a block, click SELECT on the corresponding node 
in the control flow graph pane 

On selecting a block or a loop, the source code 
corresponding to the block or loop is highlighted. 

Each selection clears the prior selection, if any. To 
clear a selection, without performing a new selection, click 
SELECT on any region of the graphics panes that do not display 
any nodes. 

The pulldown items associated with the View Menu button 
may be used to selectively view some parts of the control flow 
graph of the selected function* The operations that provide 
this functionality are described below 
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6.2 Viewing the Control Flow within a Loop 

This operation may be invoked using the first pulldown 
item. To invoke this operation, a loop should be selected. On 
choosing this item in the pulldown item, the flow of control 
within the selected loop is displayed in the control flow 
graph pane overwriting any previous data. Loops embedded 
within the selected loop are depicted as nodes (i.e. the flow 
of control within these loops is not visible). After invoking 
the operation the selection is cleared. No changes occur in 
the loop hierarchy pane or source code pane. 

6.2.1 Expanding a Loop 

This operation may be invoked using the second pulldown 
item. To perform this operation, the loop should be depicted 
as node in the graph displayed in the control flow graph pane 
and should also be selected. On choosing this item, the node 
that depicted the selected loop is replaced by a collection of 
nodes and edges representing the flow of control within the 
selected loop. All the other nodes ( i.e. apart from the node 
representing the selected loop), and the edges between them 
are retained in the new directed graph displayed in the 
graphics pane. Loops embedded within the selected loop are 
depicted as nodes (i.e. the flow of control within these loops 
is not visible). After invoking the operation the selection is 
cleared. No changes occur in the loop hierarchy pane or source 
code pane. 

6.2.2 Contracting a Loop 

This operation may be invoked using the third pulldown 
item. To perform this operation, the flow of control within 
the loop should be visible in the graph displayed in the 
control flow graph pane. The loop should also be selected. On 
choosing this item, the collection of nodes and edges that 
represented the flow of control within the loop is replaced by 
a single node depicting the selected loop. All the other nodes 
( ie. apart from the node representing the selected loop), and 
the edges between them are retained in the new directed graph 
displayed in the graphics pane. After invoking the operation 
the selection is cleared. No changes occur in the loop 
hierarchy pane or source code pane. 
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7. Report Browser 

The Report Browser is a textual tool for browsing the textual 
report for the analysed project. Clicking SELECT on this item 
displays a base window (referred as Report window later) 
containing a control area and pane. The Report window header will 
display the selected project and the footer will display the User 
name, date and time on which the project was analysed. The 
control area contains the following three buttons 

View Menu Button 
Print Report ... Window Button 
Quit Command Button 

Initially the pane will be blank. 

7.1 View Menu Button 

Clicking MENU on View Menu Button displays a pulldown menu 
containing the following items 

Report Summary (Default) 
Report on Call Graph 
Report on Functions... 
Statistics 

Report Summary 

Clicking SELECT on this item displays the global 
textual report in the pane for the project. This report 
mainly consists of the following information 

(a) The file names constituting the project, their sizes 
and total size 

(b) Number of functions defined per file and total number 
(c) List of functions defined in each file. The name' of the 

function is followed by the one or more of the 
following characters inside bracket identifying the 
type of the function 

Function not used * 
Function called recursively : : r 
Function called from unreachable block :: u 

(e) number of global variables defined per file and total 
number 

(f) list of global variables defined in each file 
(g) list of functions for which the metric values are above 

certain default value 

User can use the scrollbar to browse through the report 
text. 

Report on Call Graph 

Clicking SELECT on this item displays the report on the 
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call graph. The report mainly consists of the following 
textual information about the call graph 

(a) Total number of functions 
(b) Total number of levels in the graph 
(c) List of Library functions 
(d) List of Recursive functions 
(e) List of functions never called 
(f) List of functions called from Unreachable code 

User can use the scrollbar to browse through the report 
text. 

Report on Functions... 

Clicking SELECT on this item will display a command 
window containing a scrollable list of functions defined in 
the project. Clicking SELECT on a function in the list will 
display the textual report for this function in the pane. 
This report consists mainly of the following information 

(a) Well-formation of the control flow graph for the 
function selected 

(b) Metrics : Lines of Executable Code(LOC),No of blocks, 
Halstead's Metrics, McCabe's Number, Loop Nesting 
Depth, Fan-In and Fan-Out 

(c) Loop information : type of each loop and their nesting 
and node membership information 

(d) List of functions called directly from this function 
and function calling directly this function 

(e) Global variables used in this function 
(f) Return value type 
(g) Unreachable Code 

User can use the scrollbar to browse through the report 
text. 

Statistics 

This item has a pullright menu containing the following 
items 

Metric Distribution... (Default) 
Filter... 

Metric Distribution 

This item displays a command window containing a 
control area. The control area contains four numeric 
text fields and two command buttons named Apply and 
Cancel. The four numeric text fields are used to set the 
class intervals for displaying the metric distribution 
and are named Lines of Executable Code(default value = 
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50), Number of blocks(default value = 25), McCabe's 
Number(default value = lo) and Loop Nesting 
Depth(default value = 3). User can use the increment and 
decrement buttons to properly set the values for class 
intervals. Click SELECT on the button Apply to display 
the metric distribution as histograms in the pane of the 
Report Window. 

The display consists of four histograms showing the 
four metric distribution across different functions with 
independent scrollbars to view the histograms. 

Click SELECT on Cancel button to dismiss the command 
window. 

Filter... 

User can use this item to generate a list of 
functions satisfying the filter on metric values. 
Clicking SELECT on this item displays a command window 
containing four nonexclusivs settings named Lines of 
Executable Code, Number of Blocks, McCabe's number and 
Loop Nesting Depth. Each nonexclusive setting is 
associated with numeric textfield to input the 
corresponding metric values and a Condition menu .button 
to set the conditions viz. <, <= ==, > and >=. The 
command window also contains two command buttons Apply 
and Cancel. 

To generate the list of functions based on these 
metrics user is required to follow the following steps 

(1) first set the nonexclusive settings by clicking 
SELECT on the required metric settings 

(2) input the corresponding values in the numeric text 
fields 

(3) click MENU on the condition menu button to display 
the menu options and then click SELECT on the 
required condition 

(4) click SELECT on Apply button. The list of functions 
satisfying the metric values will be displayed in 
the Report Window pane. 

Click SELECT on Cancel button to dismiss the command 
window. 

7.2 Print Report... Window Button 

This button is provided so that any textual report 
displayed on the pane can be printed on a printer or a file. 

On clicking SELECT on this button a command window is 
displayed. This window contains an exclusive settings titled 
Destination having two options Printer and Pile and also a 
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command button named Print. 

User can designate whether a report is to be sent to a 
printer or a file by clicking SELECT on the Destination 
settings. When the Destination option is set to Printer, a 
t&xt field named Printer will be displayed. Use the Printer 
text field to specify which printer is to be used. 

When the Destination option is set to File, the text 
fields change to Directory and File. Use the text fxelds to 
specify the file and its patli name. 

Clicking SELECT on Print command button prints the file on 
to the printer 

7.3 Quit Command Button 

Click SELECT on Quit button to dismiss the Report Winclow. 
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8. Installation of the Software 

CLAS can be installed on Sun Sparc workstations having 
OpenWindows version 2 and Sun OS 4.1.1 rev B or above. 

To install CLAS distribution software follow the following 
steps 

(1) Log in as super user 
(2) Make a directory /home/clas 
(3) Insert the distribution cartridge in the tape drive 
(4) Type the following 

tar -xvf /dev/rsto clas.install 

This will copy class, install on to the directory 
/home/class. 

(5) Make clas.install executable by typing chmod +x clas.install 
(6) Execute clas.install. This will copy the CLAS software from 

the tape to the directory /home/clas and do all necessary 
initialisation tasks. This completes the installation. 

Note : CLAS can only be installed on a machine for which it is 
designated. 
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Appendix A 

List of Messages 

Normal analysis messages : 

The following messages are displayed during the normal 
analysis process considering for example "file.c" as the source 
file : 

1. Preprocessing "file.c" : 

Indicates that the source file is being preprocessed. 

2. Preprocessing completed : 

The source file has been preprocessed and the resultant 
file has been stored in "file.p". 

3. Beautifying "file.p" : 

Beautification of the preprocessed file "file.p11 is being 
carried out. 

4. Error in generating beautified file. Exiting analyser : 

If any error is encountered during the beautification 
phase, after displaying the relevant error message this message 
is displayed and the analysis is stopped. 

5. Beautification completed : 

The beautification has been completed and the resultant 
file has been stored in "file.btf". 

6. Transforming "file.btf" : 

Transformation of the beautified file "file.btf" has been 
started. 

7. Error in generating transformed file. Exiting analyser : 

If any error is encountered during the transformation 
phase, after displaying the relevant error message this message 
is displayed and the analysis is stopped. 

8. Transformation completed : 

The transformation has been completed and the resultant 
file has been stored in "file.trf". 
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9. Generating intermediate code for "file.btf"/"file.trf": 

Generating the intermediate code for the beautified file 
"file.btf" or for the transformed file "file.trf" (depending on 
the option given for the transformation). 

10. Starting postprocessing : 

Starts postprocessing on the temporary intermediate code 
and generates the final intermediate code. 

11. Postprocessing completed : 

Postprocessing to generate the final intermediate code has 
been completed. 

12. Error in generating intermediate code. Exiting analyser : 

If any error is encountered during the intermediate code 
generation phase, after displaying the relevant error message 
this message is displayed and the analysis is stopped. 

13. Intermediate code generation completed : 

The intermediate code generation has been completed and the 
output data has been stored in "file.int". The other files 
generated during this phase are "file.pre", "file.pos", 
"file.sym", "file.lab" and "file.msg". These files are later used 
for further analysis. 

14. Total number of functions = n : 

This message is displayed after the intermediate code 
generation phase; it gives total number of functions defined in 
the file. 

15. Total number of blocks = n. List of functions in the file : 

This message is displayed at the end of intermediate code 
generation; it gives total number of blocks defined in the 
intermediate code. Then lists all the functions defined in the 
analysed file. 

16. Total number of lines = n : 

This message is displayed at the end of intermediate code 
generation; it gives total number of lines (including the blank 
lines) in "file.btf" or "file.trf" (if transformation option is 
given). 

17. Total CPU time = n : 

This gives total CPU time in seconds taken by the analyser 
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from the beginning of analysis upto the intermedite code 
generation phase. 

18. First part of analysis is completed : 

This message indicates the end of intermediate code 
generation phase and the start of the next phase of analysis. 
Warning messages: 

The following warning messages may be displayed during analysis: 

1. Warning : Loop is never executed [file name : line #] : 

Indicates the loop statement is never executed - check the 
loop expression. 

2. Warning : Indefinite loop [file name : line #] : 

Indicates the loop statement is executed indefinitely 
unless there is explicit statement to come out of the loop. 

Error messages: 

The following error messages may be displayed during the 
analysis. In case of any of the following errors the analysis is 
stopped. 

1. Error : Error message related to the parser.[file name:line #] 
Token received is X : 

Indicates some error like syntax error, 'stack overflow etc 
during parsing. The corresponding error message and the token 
received at the time of error is displayed. The file name and the 
line number of the file being analysed, when the error is 
detected, is given inside the bracket. 

2. Error : Memory allocation error in function X : 

There is not sufficient memory for allocation in 
function X. 

3. Error : Array X exceeds maximum length n in function Y : 

The data in array X is exceeding its maximum length n in 
function Y. 

4. Error : Directory/Filename - no such file or directory : 

Indicates there is no directory or file as given by the 
directory or file name. 

5. Error : Directory/Filename - file not readable : 

The file in the given directory is not readable. 

i -
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6. Error : No loop open [file name : line #] : 

Indicates error in reading data from stack - may be due 
to semantical error like use of break or continue instruction 
outside a loop. The file name and the line number of the source 
file when the error has occurred is displayed inside the bracket. 

7. Error : Stack underflow in function X [file name : line #] : 

Indicates error in stack operation in the function X due to 
some malfunction. The file name and the line number of the source 
file when the error has occurred is displayed inside the bracket. 

8. Error : For transformation text buffer overflow [file name : 
line #] : 

The text buffer length to store the for-expression during 
the transformation is not sufficient. The file name and the line 
number of the source file when the error has occurred is 
displayed inside the bracket. 

9. Error : For transformation stack underflow in function X 
[file name : line #] : 

Indicates error in function X during for stack operation 
due to some malfunction. The file name and the line number of the 
source file when the error has occurred is displayed inside the 
bracket. 

Verbose Debug : 

The following are the messages which may be generated as 
additional message during verbose debug : 

1. (Function #) Function name [file name : line #, Phase -
beautification / transformation / int. code generation] : 

Displays function name with serial number indicating which 
file is currently being analysed. File name and the line number 
where the function is defined given inside the bracket and the 
phase of analysis is also displayed. 

2. Block No. = n , line = start line # , end line #, block type = 
# : 

During intermediate code generation phase displays 
information about the block generated - the block number, the 
start and end line number corresponding to the block, and the 
block type with coded number. 

3. Stage n of postprocessing started (ASCII input file name, 
output file name) : 

Indicates the 'n'th stage of postprocessing being carried 
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out. The ASCII format of output file of this stage is stored in 
the file name specified inside the bracket for viewing. 

4. Postprocessing halted in block = n : 

If for any reason the postprocessing halts this message is 
displayed with block number where the processing is halted. 

5. Stage n of postprocessing is completed : 

This message is displayed if 'n'th stage of the 
postprocessing is completed successfully. 
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$$ Hes Aw: •»-'aitt r Da ta;___ 
'fflbfesbatMiSreeQrxIdata: 
S^hltefor&Attr) 

:^lf?(Ci)resAtt^>att^llter;l«;(^10)&. 
'iltrnetricmbte^ 

I 

Ji ll, j f i ' ^ - M * ^ >A <* «< ; X"* 4} ...j 

wi$ 
*^.^ 

.„.) 

I.I 

U IH 
• * w 

Fig. 12. Control Flow Graph Browser : Base Window and View Menu 



: 47 : 

Control Flo^Cfaph^j'.ow^.&i-iUiad Project 

project Name; ^jct$/cla$c}b/cla$dbA, 

File Name; V§.byM.?&fJJ^yi!i^. 

Module Name: markRequiredRecords 

File List 

[\seby\f ilesXdVfapri v.c 
\$eby\filesVJatafile,c 
XsebyXfilesXstacl'U 
5eBTAWles\fileyt|CF 
:\$(?LvAfi!e$\auarks.c 

Module List 

makeNewRoot 
markRecordPriv 
mark Required Record; 
printindexedDataFile 
prlntRecord 

* 

VI iewj Cancel j 

Fig. 13. Control Flow Graph Load Command Window 

file:///seby/f


Published by ; Dr. M.R. Balakrishnan, Head, Library & Information Services Division 
Bhabha Atomic Research Centre, Bombay - 400 085, INDIA. 


